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Many people 
think that 
using RAW gives 
you improved 

image quality and while this is 
true, the form it comes in can be a 
little confusing. Shooting in RAW 
doesn’t give you more pixels to 
play with or extra sharpness in 
your pictures, it’s actually much 
more about flexibility and the 
ability to control results. 

All pictures start out as RAW 
data, but most of the time this is 
compressed into a JPEG before it’s 
output. In this compression, some 
of the data is discarded and it’s 
then fixed, but when you open a 
RAW file into Photoshop, all the 
original pure data is still there for 
you to use, meaning you can 
make a host of changes to your 
picture that wouldn’t be as 
successful with a JPEG.

Say, for instance, one part of 
the picture is too bright, like the 
sky. In a JPEG, nothing can be 
done because the detail has been 
lost, but in a RAW file it can be 
brought back using the Exposure 
slider. The same applies to 
returning shadow details, 
increasing the intensity of colour 
and controlling a picture’s white 
balance for more accurate hues. 

But it doesn’t end there, you 

can apply creative effects by the 
dozen too. Just turn the page to 
start learning.

Software key
These techniques 
work in Photoshop  
& Elements. Look out 
for these icons and 
you can see at a glance 
which software you 
can use.

raw lets you make changes 
to an image that would be 
impossible with a jpeg!

using raw learn with the experts

p12 tackle 
tricky 
exposures
RAW offers great control 
over the exposure in your 
pics and by combining two 
separate RAW conversions 
you’ll get perfect lighting.

p6 make a basic raw conversion 
to improve drab & dull images
Using RAW it’s easy to improve highlight and shadow detail, get 
brighter colours and enhance the sharpness of your pictures.

p16 get creative with raw files 
and apply a vintage photo effect
There’s so much more to RAW than simply controlling exposure – you 
can apply fun creative effects to your pictures too. Check out this 
technique and see how to give a picture the antique look.

p20 advanced skills in raw
If you want the ultimate in control you need to start using 
Camera Raw’s Local Adjustment tools, which let you edit 
individual parts of your picture – it’s the smart way to work! 

If you want the ultimate in image 
quality, you need to be using raw. 
fortunately it’s easy to do. find out how...

welcome

Ultimate Photoshop Coursethe basics

p8 make 
brilliant 
mono pics
Use the Basic tab in 
Photoshop or Elements’ 
Camera Raw interface to 
create dramatic black & 
white pictures that are 
bursting with 
undiscovered detail.
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White Balance & Temperature 
The drop-down White Balance list has preset options 
(Tungsten, Daylight, Cloudy etc) like those on your 
camera. These can be fine-tuned by the Temperature 
slider letting you warm up or cool down colours in relation 
to the ambient light in which it was shot. The Tint slider 
compensates for any green or magenta colour cast.

image histogram
This chart shows how the tonal values are distributed 
throughout the image you’re working on and responds to 
changes you make using the sliders below. The luminance 
value runs from left to right, so you can tell if a picture is 
heavy on the shadows (chart to the left) or the highlights 
(to the right). You can also activate the Shadows & 
Highlights clipping warnings here, which overlay a 
warning on the image – areas of red showing where 
highlights are clipped into pure white and have lost detail, 
and blue meaning detail has been lost in shadow.

Brightness, contrast & clarity
The Brightness slider lightens or darkens all of the 
tones in your image within the set black and white points, 
while Contrast makes the mid-to-light tones brighter 
and the mid-to-dark tones darker, creating separation and 
depth. The Clarity slider adds definition by increasing 
the contrast around edges within your photo, but can 
cause haloes if it’s used too aggressively.

Exposure, Recovery, Fill Light & blacks
The Exposure slider adjusts overall image brightness, 
and is biased towards the highlights. Decreasing it will 
darken your pic and increasing it will make it brighter. 
Recovery is used to restore detail in highlight areas and 
Fill Light recovers detail from the shadow areas, but 
avoids brightening the very deepest blacks. Finally 
Blacks lets you darken (or lighten) the very lowest part 
of the tonal range; the shadows of the image.

Vibrance & Saturation 
Vibrance adjusts the intensity of the least-saturated colours in the 
picture and has less effect on the more-saturated ones, which helps 
you avoid blocking out colours, while Saturation controls all the 
colours equally, so should be used sparingly.

file Info & tabs 
Under the Histogram you’ll find info about how your photo 
was shot and below that are the Tabs, in this version: Basic 
(which is currently open), Detail and Camera Calibration. 

fly-out Menu
Here you’ll find options to reset the Camera Raw Defaults, 
taking you back to an unedited starting point. 

help & save
The Help button launches the Adobe 
Community Help page, while Save Image... 
lets you save the converted RAW file without 
opening it. This is really useful when making 
batch conversions – converting multiple 
RAWs using the same settings. 

depth
This lets you set the resulting bit-depth of your converted 
file for increased quality, though it’s best left on 8-bits 
per channel unless you really want or need 16-bit images 
(many functions in Photoshop can’t be used on them). 

done, cancel & Open image
The final buttons you’ll use in the Camera Raw interface. DONE closes the 
image while retaining any settings you’ve changed. Cancel closes the 
image without recording changes and Open Image will take the picture in 
the full image-editing area of Photoshop or Elements for further work.

the toolbar
You’ll recognise many of these tools from the main image-editing area 
of Photoshop or Elements, and they’re mainly used to navigate around 
the image, crop, straighten or rotate it.

O nce you open a RAW 
into Photoshop or 
Elements the Adobe 
Camera Raw interface 

will launch and, while to 
newcomers it may seem 
complicated, it’s really just like an 
oversized Photoshop palette. 
Many of the tools involved will 
also be familiar to Photoshop or 
Elements users, so you’ll soon feel 
right at home with the interface 
and ready to get working.   

The tools you need
Over the next few pages we’ll take 
a look at the most useful tools and 
controls in the Camera Raw 
interface and tell you what they do 
when applied to your pics. We’ll 
then make a basic RAW conversion. 
The screen on the right is from 
Elements 9, so you may spot some 
differences if you’re running a 
different copy of Elements or a 
version of its big brother, the 
Photoshop CS series. Differences 
will be minor though, because here 
we’re looking at the basic tools. 
Take a quick look around to 
familiarise yourself with them, 
then turn over to start using them 
in action – it’s easier than you think!

turn over to see  
camera raw in action
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using raw make a basic raw conversion

get started 
with raw
The camera raw converter is 
your path to better images and 
you can find out what makes it 
tick right here

Ultimate Photoshop Coursethe basics
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Now we’ve taken a look at the 
Camera Raw interface it’s time to 
get stuck into a proper RAW 
conversion. So just load up the 
RAW file you’d like to work on and 
give it a try. By following this guide 
you’ll learn all about the tools you 
really need, and discover that 
RAW is the way to go if you want 
great pictures. 

The pic we’ll be using has 
various problems, all of which are 
common to many landscape shots 
and other images. For instance its 
colours are a little too cold, so it 
could do with warming up, and this 
is easy to achieve using the White 

Balance tool, menu or 
Temperature slider. But the 
biggest problem – and by 
association the greatest benefit 
of using RAW – is that we need to 
correct the exposure. Shot 
towards the sun, the sky is much 
too bright, and you can plainly see 
this as soon as you open the file by 
clicking on the Highlight clipping 
warning button. 

Any areas which are pure white 
will carry a red overlay and you’ll 
clearly be able to see that the top 
left of the picture is very burnt out 
with no cloud detail remaining. 
With a JPEG, nothing could be done 

– the detail would have been lost 
for good, but in a RAW file it can be 
brought back using the Exposure 
and Recovery sliders. Remember, 
though, that there’s no ‘correct’ 

recipe for a RAW conversion –  
but get used to what the sliders  
do and you’ll be well equipped to 
make your own. Follow this 
step-by-step to get started...
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how to convert 
multiple raws at 
the same time
There’s a lot of fine control which goes into a RAW conversion and to the 
uninitiated it can seem like too much effort, especially when you need to 
convert multiple shots. The benefit is plain though and if you’re serious 
about achieving the very best images, RAW is something that just can’t be 
beaten. There are some ways to save time however, and one of them is to 
convert lots of RAWs at the same time. 

So long as your subject matter is pretty similar from one shot to the next 
– lots of pictures of the same landscape scene or multiple studio portraits 
for instance – you can load multiple RAWs into the converter and apply the 
same settings to all of them. To do it, go to FIle➔Open and highlight all of 
the RAWs you want to convert. Click Open and once they appear in the RAW 
converter, click the Select All button. Now make your changes and they’ll 
be applied to all of the RAWs you’ve loaded at once. Easy!

work up the colours. There are some lovely brightly-
coloured beach huts in the picture, but at present their colours 
are a little muted. We can correct this with the Vibrance and 

Saturation sliders. The Vibrance slider works on the least-saturated 
colours, so first move this up to +20 to even things out, then use +20 for 
Saturation, too, making the picture more colourful overall.

correct the colours. As mentioned above, the picture 
could do with warming up. To do it, either pick the White Balance 
tool from the toolbar and click on a neutral grey tone in the 

image (like the grey clouds), or for a more manual control, take the 
Temperature slider and move it up or down. To make the most of the 
colours in our picture, we set it to 6200 with the Tint at +10.

finish sharpen the pic. We can also improve sharpness 
in RAW. First move the Amount (which controls the overall level 
of sharpening) to around 50, and the Radius (which governs how 

broad the effect is) to 1.0. Next, set the Detail to 30, which will keep the 
sharpening around edges within your pic and the Masking to 50, so 
smooth areas like the sky are omitted. Now click Open Image. That’s it!

improve the shadow areas. By moving the Exposure 
slider to a negative value we’ve darkened the sky but also the 
rest of the scene. To bring it back, move the Fill Light slider to 70, 

which will lighten these shadow areas, but leave them looking a little 
washed out. To address this, move the Blacks to 30, using the Alt-key 
preview to make sure they aren’t too heavy in your shot. 

add some contrast. As the pic was shot into the sun, the 
overall contrast has taken a bit of a hit, so for a bit more punch 
move the Contrast slider to about +70. We can also lighten up the 

picture a little using the Brightness slider and setting it at +60. Next move 
the Clarity to about +50, which will add some definition to the beach huts 
making the picture look more detailed. 

start Open & crop the image. In Photoshop or 
Elements, go to File➔Open and select your RAW image. Click 
Open and the Camera Raw interface will launch. Now click on the 

Straighten tool and drag it out along the horizon to match the angle. 
Release the button and you’ll see a crop box appear, angled to correct any 
slant in your image. Drag the corner handles in a little, then hit Return.

soften the noise. Click on the Detail tab and move down 
to the Noise Reduction sliders. Before using them, zoom in to a 
100% view, so you can see the changes taking place. Now keep 

your eye on the sky as you move the Luminance slider to around 40 and 
you’ll see the graininess much reduced. Move the Color slider up until any 
red, green or blue specs disappear – 25 works on our picture here. 

Control the highlights. Switch on the Highlight 
clipping warnings next to the Histogram and you’ll see lots of red 
in the sky showing it’s burnt out. Now set the Exposure to -1.00 

and the Recovery slider to 15 and most of, if not all the red warnings will 
disappear. If you’re not keen on the clipping warnings covering your pic, 
you can instead hold Alt as you move the slider to toggle a similar effect. 
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using raw make a basic raw conversion

how to make a basic raw conversion
the start image

The original pic 
used in this 
technique was in 
need of attention. 
Its white balance 
was too cold and 
the sky was too 
bright, resulting in 
highlight clipping.
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W orking in black & white is perhaps 
the quickest and most dramatic way that 
you can improve your images. It’s a style in 
which it’s easy to create striking shots, 

because without colour, an image is reduced to the more 
simple elements of form, texture and contrast. 

Working in RAW is the best way to go mono because you 
can use the sliders within the Adobe Camera Raw 
converter to control exposure to make sure you have the 
maximum amount of detail in your picture. And free from 
the constraints of colour, you can also apply more 
aggressive adjustments without so much fear of the image 
breaking up and looking unsightly. Still not convinced? Give 
this technique a try and you’ll definitely believe us! 

USING RAW raw to black & white

the start image

create superb 
mono images 
from raw Despite being sharply 

focused, our start image is 
lacking drama – something we 
can quickly introduce during 
our RAW conversion. By doing 
it using our special RAW-to-
mono recipe you’ll create an 
image that’s full of detail and 
shows off the subject at its 
absolute best. Try it yourself 
over the page...

Make black & white images with bags of 
gritty detail and dramatic contrast - 
it’s easy when you go mono in raw

the final image
By using the Adobe Camera Raw converter 
to turn our original colour image to black & 
white we’ve been able to create this superb 
mono image, which is bursting with detail. 

Ultimate Photoshop Coursethe basics
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In this Photoshop and Elements 
technique you’ll learn how to take 
one of your full-colour RAW files 
and turn it into a stunning black & 
white image. Sounds simple, 
right? Well yes and no. Once you 
follow the technique you’ll find it’s 
easy to do, but if you think 
creating great monotone images 
from RAW is just a matter of 

dragging the Saturation slider to 
-100, you’re in for a real treat 
because we’ll be doing a little 
more creative tinkering than that. 

There are so many ways you 
can convert to black & white in 
Photoshop that you might also be 
wondering why you’d want to do 
it from RAW in the first place – the 
answer is quality. By going mono 

directly from a RAW you can push 
your conversion amazingly hard, 
much more so than with a JPEG, 
and with the colour removed from 
your image you’re free to wring 
every last drop of drama and 
detail out of the image without 
worrying about unsightly shifts in 
hue or fringeing.  

So what do we mean by pushing 
the conversion hard? It’s all about 
grabbing the sliders and pushing 
them to their extremes, so while 
you might normally shy away from 
using large amounts of Fill Light or 
from using very high or low-
settings on the Temperature 

slider, these are the choices that 
make this technique work. With 
this kind of aggressive RAW 
conversion you may find that an 
increase in Noise can be a 
by-product, but the extra grain is 
so suited to mono images that it 
almost becomes a positive 
addition to the style of your shot.

All the tools we’ll be using are 
available in the Basic tab, so you 
can do it in any version of Adobe 
Camera Raw. And once you’ve 
seen how much better the results 
can be than from a simple 
desaturated RAW file, you’ll never 
look back. 

10    ULTIMATE PHOTOSHOP COURSE

how raw makes great mono easy...

USING RAW raw to black & white

 Desaturate the image. Now, to take all of the colour out 
of the picture, move down to the bottom of the palette and click 
and drag the Saturation slider all the way to -100. The Vibrance 

slider can be left at 0, because when moved to -100, there’s no colour left 
in the image for it to control. You’ll now have a black & white picture, but 
it’ll look a bit grey and washed out.

 control the exposure. The picture will be looking a 
little dark at this point, so click and drag the Exposure slider to a 
setting of +2.50. This will vary if you’re using your own image, 

but just hold the Alt key as you move the slider and stop when white 
areas start growing too large in the clipping preview. Moving the 
Recovery slider will minimise clipped highlights and here it’s set to 30.

start Open and crop. Select your chosen RAW file  
and once the Adobe Camera Raw interface has launched click  
on the Crop Tool from the top of the palette. Drag it out over the 

subject, losing a little of the dead space and then moving your cursor 
outside the crop box, click and drag to rotate it clockwise as shown 
above. Hit Return when you’re done. 

Set the temperature & tint. Although all of the colour 
has gone, the Temperature slider which controls White Balance 
can still have a big effect. Move it to the extremes of the scale 

and you’ll see your picture take on some interesting effects. Here we’ve 
set it to a value of 2000 which darkens the sky. The Tint slider can work in 
a similar way, though we left ours at around 0. 

43

21

 add depth to the shadows. Using a very high setting 
for Fill Light will make the picture look a little washed out, but 
you can anchor the shadows once more using the Blacks slider. 

As you did with the Exposure and Highlight sliders, hold the Alt key while 
dragging the Blacks slider and a clipping preview will show when solid 
areas of black are appearing – we stopped at a setting of 25. 

finish crisp up the details. 
Now move the Clarity slider up to a 
high setting, giving the picture more 

definition. Again, this is something you can do 
more freely in mono, so take it as high as you 
like  – we chose a setting of +90. Finally click 
on the Detail tab and, under Noise Reduction 
set Luminance to +80, then click Open image 
and you’re done!

enhance the shadow areas. Now move down to the 
Fill Light slider and drag it all the way to 100. You’ll notice lots of 
detail appear as the shadow areas of the picture are lightened. 

We’ve used the maximum amount available on our example image, but 
you should experiment to see what works best on your own shots, and 
stop when the level of detail looks right. 

increase contrast. You’ll now have a good balance, with 
‘true’ highlight and shadow areas on show. The next step is to 
increase the Contrast, so drag that slider to the right to push 

more of the midtones into the highlight and shadow areas. We settled on 
around 80, but try higher settings to see what looks right on your image. 
We also lightened the pic a little, moving Brightness to +60.

8
7

65you’ll be free to wring 
every last drop of drama 
from your image...

If you have the full version of 
Photoshop you can take even 
more control of your black & 
white images using the HSL/
Grayscale tab within Adobe 
Camera Raw. This controls the 
Hue, Saturation and 
Lightness of the individual 
colours in your image, but 
much like using the 
Temperature slider in the 
technique above, just 
because your picture is 
desaturated doesn’t mean 
you can’t still use this tab. All 
the colour information is still 
in the file for you to play with. 

To give it a go, open the image 
as normal and then, instead of 
following the steps above 
click on the HSL/Grayscale tab 
(the fourth one along). Next 
click the Convert to Grayscale 
option and you’ll be 
presented with sliders under 
the Grayscale mix heading. 
Now simply move these 
around until you get a good 
blend. Lower values will 
darken those previously 
coloured parts of the image 
they correspond to, and high 
ones will lighten them. Give it 
a go for a really creative look.

get even better mono using raw’s HSL/grayscale tab

Ultimate Photoshop Coursethe basics



One of the biggest 
challenges for a 
landscape 
photographer is 

overcoming contrast. All too often, 
the sky is much brighter than the 
foreground, and because your 
camera can’t take in the same 
range of brightness as your eyes, it 
means your shots will look 
unbalanced. If you expose 
correctly for the sky, your land will 

be too dark for a pleasing image, 
and if you allow the foreground to 
govern your exposure settings, 
the sky will be burnt out into an 
empty white patch that’s devoid of 
detail. A solution can be found by 
using graduated neutral density 
filters over the lens to darken the 
sky, but this can be fiddly and time 
consuming. Want a better fix for an 
age-old problem? Of course you do 
– just read on to find it...
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the final image
Our sky and foreground are nicely 
balanced, with good levels of 
detail in both. It’s a world apart 
from our starting point.

using raw balancing exposure

balance your 
shots in raw
perfect your pictures by blending 
together different raw 
conversions of the same image

the start image

The landscape  
pic used in this 
technique is 
suffering from  
an underexposed 
foreground and 
lack of impact due 
to the imbalanced 
exposure. 

Ultimate Photoshop Coursethe basics
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using layer masks to 
blend your different 
raw conversions 
In this exercise, we’ve used the Eraser Tool to create the blend between 
one RAW conversion and the other. While this is intuitive, it’s not the most 
refined way of working, as once you’ve removed the pixels you have no 
simple way of backtracking other than the Undo History – and this isn’t 
retained when you save the file. A better, more advanced method is to use 
a Layer Mask instead, as this lets you hide or reveal the pixels from the 
Layer beneath, without removing them. All versions of Photoshop feature 
Layer Masks, and Elements 9 and 10 also have them too. Instead of using 
the Eraser on Step 6, click the Layer Mask icon in the Layers palette. Then 
you simply use a black paintbrush to ‘make a hole’ in the Layer and reveal 
the pixels from beneath, or use a white brush to hide them. 

 Make the sky conversion. Ignoring the dark 
foreground and focusing solely on the sky, tweak the sliders in 
the RAW converter to get the best-looking result. The settings 

you use will be different for each image you convert, but for our file we 
went for Temperature 6300, Tint +10, Exposure -0.20, Brightness +50 
and Contrast +18. All the other settings were on zero. 

finish warm up the image. Click the Adjustment Layer 
icon once more and again, select Levels. In the Levels palette, 
click where it says RGB and choose the Red channel. Move the 

midpoint slider a little to the left. Now click where it says Red and choose 
the Blue channel. Move the same slider slightly to the right, and you’ll 
have a fabulous warm-up effect to finish off your picture.

Make the land conversion. Open the original file 
again, and you’ll bring up the RAW with the settings you’ve just 
made. Now ignore the sky and adjust the sliders to give a 

good-looking foreground. On our image, we went for Temperature 6450, 
Tint +10, Exposure +1.90, Fill Light 21,  Blacks 16, Brightness +50 and 
Contrast +40. All other settings were on zero. Click Open Image again.

blend the pics together. To get the best from both 
conversions, pick up the Eraser Tool and in the Options bar at the 
top of the screen, choose a large, soft-edged brush, and run it 

across the sky to reveal the better sky from the Layer beneath. As you 
approach the skyline, drop the Opacity to around 50%, and work over 
the mountains to get a natural-looking blend between the two Layers.

START assess the problem. Open your landscape image 
into Photoshop or Elements and it’ll load into Adobe Camera Raw. 
Here we have a common landscape problem – the foreground is 

very under-exposed compared to the sky. To solve this we’ll make two 
conversions – one for the sky and one for the land – and then we’ll blend 
them together. They’re from the same file so they’ll line up perfectly. 

add a little drama . We’re getting close now, but the sky 
could do with a bit of extra oomph. With the Lasso Tool, select 
the top part of the sky and then click the Refine Edge button  

and move the Feather slider to 150px. In the Layers palette, click the 
Adjustment Layer icon and choose Levels from the list, then move the 
black point and midpoint sliders a little to the right to darken the sky.

Open and save the sky. Click on Open Image at the 
bottom of the RAW dialog, and the picture will load into the 
regular interface. It’s a good idea to save this conversion so you 

can always come back to it, so go to File➔Save As and give it a suitable 
name. Photoshop’s native format will give the best quality, so pick that  
in Save As.  Once you’ve done this, just leave it on screen.

combine the two versions. Once the foreground 
conversion appears, hit Ctrl+A to select it, and then Ctrl+C to 
copy it. You can now close it by hitting Ctrl+W (you don’t need to 

save it). The image with the good sky will now be on screen, so hit Ctrl+V 
and your foreground conversion will be pasted into the same document. 
Go to Window ➔Layers and you’ll see them stacked in the Layers palette.

4

6

3
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USING RAW retro film effects

use raw for 
easy retro 
film effects

 the start image

The start image used in this technique 
was taken at a WWII re-enactment 
weekend and shows the homeguard 
taking a more relaxed approach to life. 
With such attention to detail when it 
comes to uniforms and vehicles, it was 
crying out for the retro film treatment. 

add toning and colour effects to your 
raw files for a brilliant vintage look

Ultimate Photoshop Coursethe basics

the final image
With suitable toning and faded 
colours, this modern RAW file 
becomes a dead ringer for an 
aged, distressed vintage print.
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Throughout this chapter we’ve 
been looking at how editing your 
camera’s RAW files can help you 
get better pictures, but RAW isn’t 
just about improving image 
quality – you can use it to apply 
great creative effects, too! That’s 
what we’ll be doing in this 
technique, taking a regular 
looking image and giving it a 

vintage make-over, using some 
of the lesser-used tabs within 
the Adobe Camera Raw interface. 
In a few clicks you’ll discover that 
you can give any picture a faded 
and vintage charm. 

We’ll first be using the HSL / 
Grayscale tab to change the 
colours in the picture, making 
them somewhat less than true to 

life and mimicking the hit-and-
miss results of early colour film 
and the look of a decaying print. 
Next we’ll use the Split Toning 
tab to apply separate hues to the 
highlights and shadows of our 
picture, furthering the vintage 
effect, before finally using the FX 
tab to place a light vignette on 
the image and also give it a light 
dusting of film grain. 

Now if you’re looking at your 
version of Adobe Camera Raw 
and you can’t find those tabs, 
you’re almost certainly running 
Photoshop Elements, or an older 
version of Photoshop CS – 

something before Photoshop 
CS3 – because these tabs only 
appear in the later versions. It’s 
just one of the extras that come 
with the full package. 

Before adding the vintage 
effect we will need to apply a few 
basic exposure changes under 
the Basic tab to make sure there’s 
plenty of detail in the image. 

Remember you’re not limited 
to retro-styled subjects such as 
vintage re-enactments – this 
simple technique can give an 
aged feel to contemporary 
portraits, too. Give it a try and 
you might be surprised...
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cook up a retro film effect in raw...

 change the colour range. Now, click on the HSL/
Grayscale tab (the fourth one along in the full version of 
Photoshop). Here you can control the individual colours that 

make up the image, independently altering their Hue, Saturation and 
Luminance to suit. Start by making the colours less true to life under the 
Hue tab by setting the sliders as shown above.

 control saturation. Finally, under the HSL/Grayscale 
tab, click on the Saturation settings. These control the intensity 
of individual colours, and in the case of our example image, we 

want to increase saturation in the Reds and Oranges and lower it in the 
Greens and Yellows as shown. After these settings in the HSL tab, you 
should have an interesting looking technicolour effect!

start Open & use the basic tab. Open your RAW 
image to launch the Camera Raw Converter, then set the White 
Balance to Daylight, Tint to +20, Exposure to -0.50, Recovery to 

0, Fill Light to 80, Blacks to 10, Brightness to +50, Contrast to -30 and 
Clarity to -60 (the latter two to give the pic a faded look). Finally leave 
Saturation and Vibrance sliders at 0. 

alter luminance. Next click on the Luminance settings. 
Here you can control the brightness of individual colours, so for 
instance if you want to make the green grass in a picture lighter, 

but not alter anything else, you’d move the Greens and Yellows sliders 
up. Again, for our example pic, follow the settings above, but when using 
your own shots make sure you experiment to see what looks best. 
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 recolour the shadows. Next it’s time to add a similar 
effect to the shadows, so move down the tab to that heading. 
Again, set the Saturation to around 30 and move the Hue slider 

– we’ve gone for some cooler shadows here using a blue colour with the 
Hue set to 245. Finally, tweak the Balance slider to bias the effect 
towards the highlights at the left of the shadows at the right (-10 here). 

 finish add some grain. A dusting of grain will also suit 
the vintage effect, so under Grain, set Amount to 30. Size, which 
controls the size of the individual ‘grains’ can be moved up to 

around 50 and Roughness, which controls the contrast within the Noise, 
can also be set to 50. For all three, higher values will give coarser images. 
Finally, hit Open Image to complete your retro conversions.

recolour the highlights. Now click on the Split Toning 
tab next to the HSL/Grayscale tab and move down under the 
Highlights heading. Set the Saturation to 30 and then move the 

Hue slider to add a toning effect to the light parts of the image. Warmer 
highlights tend to work best, but just see what suits your image. Here, 
we went for an orange colour, setting Hue to 35.

add a vignette. To finish off, we’ll add a vignette. On some 
pics, darker edges work, but here a lightening of the corners is 
what we’re after. Click on the FX tab and under Post Crop 

Vignette, pick Color Priority. Move the Amount slider to +60 (a negative 
setting will darken the edges) and then alter the position and shape of the 
vignette to suit with the Midpoint, Roundness and Feather sliders.
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65We’ll use various tabs in 
raw to give our picture a 
faded vintage charm...

Once you’ve created your 
vintage photo effect recipe, 
there’s a good chance that 
you’ll want to apply it to other  
images in your collection. To do 
it, click on the fly-out menu 
next to the Tabs and pick the 
option marked Save Settings... 

You’ll then be prompted to 
tick which settings you want 
to save (see the list on the 
right), so make sure that all the 
ones you want to apply are 
ticked. For example, here 
we’ve ticked the majority of 
them, including the HSL 
Adjustments, Split Toning, 

Post Crop Vignette and Grain 
boxes. However, it’s a good 
idea to untick the settings 
input under the Basic tab as 
these will vary more widely 
from image to image. Now click 
Save and you’ll be prompted to 
give a name to your effect, so 
type that in and hit OK. 

Now, when you load up any 
image, you’ll be able to click on 
the Presets tab and choose the 
effect you save from the list. 
It’s a great way to save time 
when applying creative effects 
to your RAWs, so make sure 
you give it a try. 

save your vintage effect as a raw recipe

save a preset
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We’ve seen how  
a RAW file can be 
converted a number 
of times and 

blended together to give different 
exposure and contrast effects to 
different parts of the scene, but 
imagine how great it would be if 
you could do all this in one single 
RAW conversion. Well, provided 
you have the full version of 
Photoshop (CS4 or higher), you 

can. It’s all made possible thanks to 
the Adjustment Brush, which 
allows you to apply different RAW 
conversion settings to different 
areas of an image. On top of that, 
there’s also a nifty tool that applies 
a graduated filter effect, so in this 
tutorial, we’ll explore both and see 
how you can make dramatic 
changes to exposure, colour and 
contrast in different parts of your 
pictures in one fell swoop...
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the final image
Considering the rough starting 
point, this seaside scene has 
polished up rather well in RAW, 
with a perfect balance to the 
exposure and contrast.

using raw advanced skills

advanced  
raw skills
Use the adjustment brush and 
graduated filter tools to 
convert raws like a pro

the start image

The start pic used 
in this technique 
has potential but 
needs attention. 
It’s underexposed, 
the white balance 
is too cold and the 
horizon is wonky. 
Let’s get to work! 

Ultimate Photoshop Coursethe basics
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using multiple 
adjustments & grads 
To keep things as versatile as possible, you can use several different 
Adjustment Brushes and Graduated Filters, all with different effects. 
Above, we’ve used three grads to subtly enhance the sky, and on the left, 
you can see the ‘pins’ of  five different Adjustment Brushes to fine-tune 
the Exposure and Contrast settings over the scene. The beauty of multiple 
localised adjustments like this is that you can work on particular sections 
within an image with each tool, rather than trying to make a complex 
alteration over the whole scene with just one grad or Adjustment Brush. 

To create a new Adjustment Brush, simply hit K and then ensure that 
New is selected at the top of the palette. For a new Graduated Filter, hit G 
and drag on the image. In both cases, you’ll need to avoid clicking on any 
existing adjustment pins that are present, as this will take you into the 
editing mode on that particular pin, and allow you to further alter it.

 brighten the foreground. We need to get the 
foreground looking better as it’s currently under-exposed, so 
move the Exposure slider to the right until the foreground’s 

lighting has improved. On our image, we ramped up the Exposure to 
+1.80  – nearly two stops above our in-camera setting. Your sky will 
bleach out when you do this, but don’t worry, as we can bring it back. 

finish reduce the grad strength. We’re just about 
there now, but the grad is looking a little unnatural at the top. To 
reduce its strength, hit G to select the Graduated Filter again 

and click on one of the small circles to make the grad editable. Move the 
Exposure slider back to about -0.60 to soften the effect, and then hit 
Open Image to load the picture into the standard Photoshop interface.

use the adjustment brush. At the bottom of the 
palette, set Feather, Flow and Density to 100, and then set Size 
so the brush covers half the height of the sky (14 on our pic). 

Now paint over the sky, and run the brush down so the feathered edge 
touches the horizon. The sky will darken, thanks to the new Exposure 
value we’ve applied to the painted area. Tick Show Mask and you’ll see it.

Apply a grad filter effect. To give a traditional look 
and further darken the top of the sky, select the Graduated 
Filter (G) and set the Exposure to -1.00, and all the other sliders 

to 0. Click on the very top of the image and drag downwards to the top of 
the groynes, and you’ll see the green and red dashed lines that indicate 
the start and finish of the graduated effect.

START straighten the raw. Open your RAW file into 
Photoshop CS4 or higher, and it’ll load into Camera Raw. The first 
thing we need to address here is the wonky horizon, so select the 

Straighten tool from the Toolbar, and drag the mouse along the horizon 
from the left. Release the mouse on the right of the horizon and the 
image will straighten up. Double-click to see the squared-up image.  

tweak the settings. With the main changes made, 
return to the regular interface by clicking on the Hand Tool, and 
you can now fine-tune your conversion, adjusting all the effects 

you’ve created along with the image itself. To get a bit more detail into 
the foreground, push Fill Light up to around 30, and then to prevent it 
looking too washed out, boost Blacks to 10 to thicken the shadows.

add a hint of warmth. The image is looking a little cool 
at the default White Balance setting, so move the Temperature 
slider up to around 6500 to warm things up. With that done, click 

on the Adjustment Brush (or hit the shortcut K) and with New selected at 
the top of the palette, move the Exposure slider down to about -1.50. 
Nothing will change, as we haven’t used the brush yet.

adjust the brush. It’s called the Adjustment Brush for a 
good reason, because we can now apply further changes to the 
area covered by it. We need our sky to be a bit darker, so move 

the Exposure slider to the left until the pic looks nicely balanced. We 
went for -2.00, and to give the clouds more stand-out, we then ramped 
up the Contrast to +50. We left all the other sliders set to 0.
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